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1 Introduction And Scope

Reflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which
employs a workflow engine to provide a real-time visual representation of a data reduction cascade, called a
workflow, which can be easily understood by most astronomers. The basic philosophy and concepts of Reflex
have been discussed by Freudling et al. (2013A&A...559A..96F). Please reference this article if you use Reflex
in a scientific publication.

Reflex and the data reduction workflows have been developed by ESO and instrument consortia and they are
fully supported. If you have any issue, please contact usd-help@eso.org for further support.

This document is a tutorial designed to enable the user to employ the VIMOS workflow to reduce his/her data in
a user-friendly way, concentrating on high-level issues such as data reduction quality and signal-to-noise (S/N)
optimisation.

A workflow accepts science and calibration data, as delivered to PIs in the form of PI-Packs (until October
2011) or downloaded from the archive using the CalSelector tool1 and organises them into DataSets, where each
DataSet contains one science object observation (possibly consisting of several science files) and all associated
raw and static calibrations required for a successful data reduction. The data organisation process is fully
automatic, which is a major time-saving feature provided by the software. The DataSets selected by the user
for reduction are fed to the workflow which executes the relevant pipeline recipes (or stages) in the correct
order. Full control of the various recipe parameters is available within the workflow, and the workflow deals
automatically with optional recipe inputs via built-in conditional branches. Additionally, the workflow stores the
reduced final data products in a logically organised directory structure employing user-configurable file names.

This tutorial deals with the reduction of VIMOS MOS spectroscopic observations only via the VIMOS/MOS
workflow. The user is referred to the VIMOS web page (http://www.eso.org/sci/facilities/paranal/instruments/vimos/)
for more information on the instrument itself, and the VIMOS pipeline user manual for the details of the pipeline
recipes (http://www.eso.org/sci/software/pipelines/).

The workflow uses association rules known to work with files downloaded from the ESO archive with the
CalSelector tool (from year 2009 onwards).

1http://www.eso.org/sci/archive/calselectorInfo.html

mailto:usd-help@eso.org
http://www.eso.org/sci/archive/calselectorInfo.html
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2 Software Installation

The software pre-requisites for Reflex 2.8 may be found at:
http://www.eso.org/sci/software/pipelines/reflex_workflows

To install the Reflex 2.8 software and demo data, please follow these instructions:

1. From any directory, download the installation script:

wget ftp://ftp.eso.org/pub/dfs/reflex/install_esoreflex

2. Make the installation script executable:

chmod u+x install_esoreflex

3. Execute the installation script:

./install_esoreflex

and the script will ask you to specify three directories: the download directory <download_dir>, the
software installation directory <install_dir>, and the directory to be used to store the demo data
<data_dir>. If you do not specify these directories, then the installation script will create them in the
current directory with default names.

4. You will be asked whether you want to use your Internet connection. Unless you want to reuse already
downloaded packages (only advanced users), use the default Yes.

5. You will be given a choice of pipelines (with the corresponding workflows) to install. Please specify the
numbers for the pipelines you require, separated by a space, or type “A” for all pipelines.

6. For the pipelines to be installed you will be prompted for the demo data sets to be installed. Type “A” for
all demo datasets. Take into account that if you are installing in a directory that already contains data, it
won’t be removed.

7. The script will also detect whether previous versions of the workflows or Reflex were installed and in this
case you have the option to update links or remove obsolete cache directories. It is advised to use the
defaults.

8. To start Reflex, issue the command:

<install_dir>/bin/esoreflex

It may also be desirable to set up an alias command for starting the Reflex software, using the shell com-
mand alias. Alternatively, the PATH variable can be updated to contain the <install_dir>/bin
directory.

http://www.eso.org/sci/software/pipelines/reflex_workflows
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3 Demo Data

Together with the pipeline you will also receive a demo data set, that allows you to run the Reflex VIMOS
workflow without any changes in parameters. This way you have a data set to experiment with before you start
to work on your own data. The demo data for VIMOS includes both data for the IFU and MOS workflows, but
a given workflow will only use the data for that mode.

Note that you will need a minimum of ∼1.3 GB, ∼0.6 GB and ∼7.0 GB of free disk space for the directories
<download_dir>, <install_dir> and <data_dir>, respectively. The VIMOS demo data have been
retrieved with the CalSelector tool2.

2http://www.eso.org/sci/archive/calselectorInfo.html

http://www.eso.org/sci/archive/calselectorInfo.html
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4 Quick Start: Reducing The Demo Data

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe
the steps to be performed to reduce the science data provided in the VIMOS demo data set supplied with
the Reflex 2.8 release. By following these steps, the user should have enough information to attempt a
reduction of his/her own data without any further reading:

Figure 4.1: The empty Reflex canvas.

1. Start the Reflex application:

esoreflex &

The empty Reflex canvas as shown in Figure 4.1 will appear.

2. Now open the VIMOS workflow by clicking on File -> Open File, selecting first vimos-3.0.4
and then the file VimosMos.xml in the file browser. You will be presented with the workflow canvas
shown in Figure 4.2. Note that the workflow will appear as a canvas in a new window.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlight-
ing. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the
animation interval (100 ms is recommended), and click OK .

4. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important direc-
tories (green dots). Setting the value of ROOT_DATA_DIR is the only necessary modification if you want
to process data other than the demo data3, since the value of this parameter specifies the working direc-
tory within which the other directories are organised. Double-click on the parameter ROOT_DATA_DIR
and a pop-up window will appear allowing you to modify the directory string, which you may either edit
directly, or use the Browse button to select the directory from a file browser. When you have finished,
click OK to save your changes.

3If you used the install script install_esoreflex, then the value of the parameter ROOT_DATA_DIR will already be set
correctly to the directory where the demo data was downloaded.
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5. Click the button to start the workflow

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data directory
(specified by the parameter RAWDATA_DIR under “Setup Directories” in the workflow canvas) and con-
structs the DataSets. Note that the raw and static calibration data must be present either in RAWDATA_DIR
or in CALIB_DATA_DIR, otherwise DataSets may be incomplete and cannot be processed. However,
if the same reference file was downloaded twice in different places this creates a problem as Reflex
cannot decide which one to use.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window
(see Figure 4.3) that lists the DataSets along with the values of a selection of useful header keywords4.
The first column consists of a set of tick boxes which allow the user to select the DataSets to be processed,
and by default all complete DataSets are selected.

8. Click the Continue button and watch the progress of the workflow by following the red highlighting
of the actors. A window will show which DataSet is currently being processed.

9. When the reduction of the current DataSet finishes, a pop-up window called Product Explorer will appear
showing the datasets which have been so far reduced together with the list of final products. This actor
allows the user to inspect the final data products, as well as to search and inspect the input data used to
create any of the products of the workflow. Figure 4.5 shows the Product Explorer window.

10. The workflow will continue with the remaining DataSets following the same steps described above.

11. After the workflow has finished, all the products from all the DataSets can be found in a directory under
END_PRODUCTS_DIR with the named with the workflow start timestamp. Further subdirectories will
be found with the name of each DataSet.

Well done! You have successfully completed the quick start section and you should be able to use this knowledge
to reduce your own data. However, there are many interesting features of Reflex and the VIMOS workflow
that merit a look at the rest of this tutorial.

4The keywords listed can be changed by right-clicking on the DataOrganiser Actor, selecting Configure Actor, and then
changing the list of keywords in the second line of the pop-up window.
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Figure 4.2: VIMOS/MOS workflow general layout.

Figure 4.3: The “Select Datasets” pop-up window.
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Figure 4.4: The interactive window of the fors_calib actor for the first demo DataSet..

Figure 4.5: The Provenance Explorer shows all datasets reduced in previous executions together with the full
reduction chain for all the pipeline products.
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5 About The Reflex Canvas

5.1 Saving And Loading Workflows

In the course of your data reductions, it is likely that you will customise the workflow for various data sets, even
if this simply consists of editing the ROOT_DATA_DIR to a different value for each data set. Whenever you
modify a workflow in any way, you have the option of saving the modified version to an XML file using File
-> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved
workflow may be opened in subsequent Reflex sessions using File -> Open. Saving the workflow in the
default format (.kar) is only advised if you do not plan to use the workflow in another computer.

5.2 Buttons

At the top of the Reflex canvas are a set of buttons which have the following useful functions:

• - Zoom in.

• - Reset the zoom to 100%.

• - Zoom the workflow to fit the current window size (Recommended).

• - Zoom out.

• - Run (or resume) the workflow.

• - Pause the workflow execution.

• - Stop the workflow execution.

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

5.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the

yellow highlighting of the , , and buttons, respectively. A workflow is executed by clicking the
button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the

button, or the workflow may be paused by clicking the button which will allow the current actor/recipe
to finish execution before the workflow is actually paused. After pausing, the workflow may be resumed by

clicking the button again.
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6 The VIMOS Workflow

The VIMOS workflow canvas is organised into a number of areas. From top-left to top-right you will find
general workflow instructions, directory parameters, and global parameters. In the middle row you will find five
boxes describing the workflow general processing steps in order from left to right, and below this the workflow
actors themselves are organised following the workflow general steps.

6.1 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user. Under “Setup Directories” the
user is only required to set the RAWDATA_DIR to the working directory for the DataSet(s) to be reduced, which,
by default, is set to the directory containing the demo data. The RAWDATA_DIR is recursively scanned by the
Data Organiser actor for input raw data. The directory CALIB_DATA_DIR, which is by default within
the pipeline installation directory, is also scanned by the Data Organiser actor to find any static calibrations
that may be missing in your DataSet(s). If required, the user may edit the directories BOOKKEEPING_DIR,
LOGS_DIR, TMP_PRODUCTS_DIR, and END_PRODUCTS_DIR, which correspond to the directories where
book-keeping files, logs, temporary products and end products are stored, respectively (see the Reflex User
Manual for further details; Forchì (2012)).

Under the “Global Parameters” area of the workflow canvas, the user may set the FITS_VIEWER parameter to
the command used for running his/her favourite application for inspecting FITS files. Currently this is set by
default to fv, but other applications, such as ds9, skycat and gaia for example, may be useful for inspecting
image data.

By default the EraseDirs parameter is set to false, which means that no directories are cleaned before
executing the workflow, and the recipe actors will work in Lazy mode (see Section 6.2.4), reusing the previous
pipeline recipe outputs where input files and parameters are the same as for the previous execution, which saves
considerable processing time. Sometimes it is desirable to set the EraseDirs parameter to true, which
forces the workflow to recursively delete the contents of the directories specified by BOOKKEEPING_DIR,
LOGS_DIR, and TMP_PRODUCTS_DIR. This is useful for keeping disk space usage to a minimum and will
force the workflow to fully rereduce the data each time the workflow is run.

The parameter RecipeFailureMode controls the behaviour in case that a recipe fails. If set to Continue,
the workflow will trigger the next recipes as usual, but without the output of the failing recipe, which in most
of the cases will lead to further fails of other recipes without the user actually being aware of it. This mode
might be useful for unattended processing of large number of datasets. If set to Ask, a pop-up window will ask
whether the workflow should stop or continue. This is the default. Additionally, the Stop mode will stop the
workflow execution immediately.

The parameter GlobalInteractivity controls whether the interactive windows will appear for those win-
dows which are enabled by default. The possible values are true, false. Take into account that some
windows are disabled in the default configuration and therefore are not affected by this parameter.

The parameter ProductExplorerEnabled controls whether the ProductExplorer actor will show its
window or not. The possible values are true, false.
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6.2 Workflow Actors

6.2.1 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They
may also have a logo within the rectangle to aid in their identification. The following actors are simple actors:

• - The Data Organiser actor.

• - The Data Set Chooser actor.

• - The Fits Router actor

• - The Product Renamer actor.

• - The Product Explorer actor.

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting Configure
Actor. This will open an “Edit parameters” window. Note that the Product Renamer actor is a jython
script (Java implementation of the Python interpreter) meant to be customised by the user (by double-clicking
on it).

6.2.2 Composite Actors

Composite Actors have workflow symbols that consist of multiply-layered green-blue rectangles. They gener-
ally do not have a logo within the rectangle. A Composite Actor represents a combination of more Simple or
Composite Actors which hides over-complexity from the user in the top-level workflow.

Composite Actors may also be expanded for inspection. To do this, right-click on the actor and select Open
Actor, which will expand the Composite Actor components in a new Reflex canvas window. If the Com-
posite Actor corresponds to a pipeline recipe, then the corresponding RecipeExecuter actor will be present
as a Simple Actor, and its parameters are accessible as for any other Simple Actor. Alternatively you may still
find Composite Actors, on which you need to repeat the first step to access the Recipe Executer.

6.2.3 Recipe Execution within Composite Actors

The VIMOS workflow contains Composite Actors to run pipeline recipes. This is in the most simple case due
to the SoF Splitter/SoF Accumulator5, which allow to process calibration data from different setting

5SoF stands for Set of Files, which is an ASCII file containing the name (and path) of each input file and its category (e.g. BIAS).
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within one given DataSet (e.g. lamp frames taken with different slits/masks). More complex Composite Actors
contain several actors (e.g. Recipe Executer).

Figure 6.1: This is the window you get when you choose Open Actor for the Composite Actor MasterBias.
This is the most simple case for a Composite Actor. Using Configure Actor on vimos_bias_1 gives
you Fig. 6.2.

The central elements of any Reflex workflow are the RecipeExecuter actors that actually run the recipes.
One basic way to embed a RecipeExecuter in a workflow is shown in Fig 6.1, which is the most simple
version of a Composite Actor. The RecipeExecuter is preceded by an SofSplitter, and followed by
an SofAccumulator. The function of the SofSplitter is to investigate the incoming SoFs, sort them
by “purpose”, and create separate SoFs for each purpose. The RecipeExecuter then processes each of
the SoFs independently (unless they are actually the same files). Finally, the SofAccumulator packs all
the results into a single output SoF. The direct relation between the SofSplitter and SofAccumulator
is used to communicate the number of different SoFs created by the SofSplitter. A workflow will only
work as intended if the purpose of all the files a recipe needs as input is identical. The only exception to this
rule is that a purpose can also be “default”. In this case, the file is included in any output SoF created by the
SoFsplitter and SofAccumulator.

The reason for this scheme is best explained by an example. For a complex DataSet, the Data Organiser
might have selected a large number of individual raw lamp frames (arc and flat field). The different lamp frames
are to be used to calibrate different frames, e.g. the science frames and the standard star frames. The Data
Organiser determines and records this “purpose” of each lamp frame, and this information is included in the
DataSet and each SoF created from this DataSet. The FitsRouter directs all raw lamp frames to the calibra-
tion Composite Actor. The SofSplitter then creates SoFs, one for the lamp frames to be used for the science
frames, and (probably) separate ones for the lamp frames to be used for the standard star observations. The cal-
ibration recipe creates one master flat field (and other products) for each SoF, and the SofAccumulator then
creates a SoF that contains all the products.

A RecipeExecuter actor is used in the workflow to run a single VIMOS pipeline recipe (e.g: in the
MasterBias actor the recipe vmbias is executed). In order to configure the RecipeExecuters, one
has to first use Open Actor to get to the level of the recipe executors (see Fig. 6.1).

In Figure 6.2 we show the “Edit parameters” window for a typical RecipeExecuter actor, which can be
displayed by right-clicking on the actor and selecting Configure Actor. In the following we describe in
more detail the function of some of the parameters for a RecipeExecuter actor:

• The “recipe” parameter states the VIMOS pipeline recipe which will be executed.
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Figure 6.2: The “Edit parameters” window for a typical RecipeExecuter actor, the vmbias_1 actor
which runs the vmbias pipeline recipe.

• The “mode” parameter has a pull-down menu allowing the user to specify the execution mode of the actor.
The available options are:

– Run: The pipeline recipe will be executed, possibly in Lazy mode (see Section 6.2.4). This option
is the default option.

– Skip: The pipeline recipe is not executed, and the actor inputs are passed to the actor outputs.
– Disabled: The pipeline recipe is not executed, and the actor inputs are not passed to the actor

outputs.

• The “Lazy Mode” parameter has a tick-box (selected by default) which indicates whether the RecipeExecuter
actor will run in Lazy mode or not. A full description of Lazy mode is provided in Sect. 6.2.4.

• The “Recipe Failure Mode” parameter has a pull-down menu allowing the user to specify the behaviour
of the actor if the pipeline recipe fails. The available options are:

– Stop: The actor issues an error message and the workflow stops.
– Continue: The actor creates an empty output and the workflow continues.
– Ask: The actor displays a pop-up window and asks the user whether he/she wants to continue or

stop the workflow. This option is the default option.
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Table 6.1: The VIMOS/MOS pipeline actors and their contents
actor recipe description
MasterBias vmbias create master bias

VimosMosCalib vmmoscalib create master flat, determine coefficients for wave-
length calibration and correction of spatial distortion

Response Curve vmmosscience determine response function

VimosScience vmmosscience reduce science data

• The set of parameters which start with “recipe param” and end with a number or a string correspond
to the parameters of the relevant VIMOS pipeline recipe. By default in the RecipeExecuter actor,
the pipeline recipe parameters are set to their pipeline default values. If you need to change the default
parameter value for any pipeline recipe, then this is where you should edit the value. For more information
on the VIMOS pipeline recipe parameters, the user should refer to the VIMOS pipeline user manual (Izzo
et al. 20126).

The description of the remainder of the RecipeExecuter actor parameters are outside the scope of this tuto-
rial, and the interested user is referred to the Reflex User Manual for further details (Forchì 2012). Any changes
that you make in the “Edit parameters” window must be saved in the workflow by clicking the Commit button
when you have finished to take effect. If you want to reuse the parameters you have to save the workflow with
the saved parameters.

6.2.4 Lazy Mode

By default, all recipe executer actors in a pipeline workflow are “Lazy Mode” enabled. This means that when
the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has
already been executed with the same input files and with the same recipe parameters. If this is the case, then the
actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products
to the output port. The purpose of the Lazy mode is therefore to minimise any reprocessing of data by avoiding
data rereduction where it is not necessary.

One should note that the actor Lazy mode depends on the contents of the directory specified by
BOOKKEEPING_DIR and the relevant FITS file checksums. Any modification to the directory contents and/or
the file checksums will cause the corresponding actor when executed to run the pipeline recipe again, thereby
rereducing the input data.

The forced rereduction of data at each execution may of course be desirable. To force a rereduction of all data
for all RecipeExecuter actors in the workflow (i.e. to disable Lazy mode for the whole workflow), set the
EraseDirs parameter under the “Global Parameters” area of the workflow canvas to true. This will then
remove all previous results as well. To force a rereduction of data for any single RecipeExecuter actor
in the workflow (which will be inside the relevant composite actor), right-click the RecipeExecuter actor,
select Configure Actor, and uncheck the Lazy mode parameter tick-box in the “Edit parameters” window

6Available at ftp://ftp.eso.org/pub/dfs/pipelines/vimos/vimos-pipeline-manual-7.0.pdf

ftp://ftp.eso.org/pub/dfs/pipelines/vimos/vimos-pipeline-manual-7.0.pdf
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that is displayed. If the Lazy mode is switched off for an actor, all subsequent actors that use products from that
one will also reprocess the data, as they see new products.

6.3 Workflow Steps

6.3.1 Step 1: Data Organisation And Selection

On clicking the button on the Reflex canvas, the workflow will highlight and execute the Initialise
actor, which among other things will clear any previous reductions if required by the user (see Section 6.1).

1. The DataOrganiser (DO) is the first crucial component of a Reflex workflow. The DO takes as
input RAWDATA_DIR and CALIB_DATA_DIR and it detects, classifies, and organises the files in these
directories and any subdirectories. The output of the DO is a list of “DataSets”. A DataSet is a special Set
of Files (SoF). A DataSet contains one or several science (or calibration) files that should be processed
together, and all files needed to process these data. This includes any calibration files, and in turn files
that are needed to process these calibrations. Note that different DataSets might overlap, i.e. some files
might be included in more than one DataSet.

A DataSet lists three different pieces of information for each of its files, namely 1) the file name (in-
cluding the path), 2) the file category, and 3) a string that is called the “purpose” of the file. The DO
uses OCA7 rules to find the files to include in a DataSet, as well as their categories and purposes. The
file category identifies different types of files. A category could for example be MOS_SCREEN_FLAT,
MOS_ARC_SPECTRUM or MOS_SCIENCE. The purpose of a file identifies the reason why a file is
included in a DataSet. The syntax is action_1.action_2.action_3. ... .action_n,
where each action_i describes an intended processing step for this file. The actions are defined in
the OCA rules and contain the recipe together with all file categories required to execute it (and pre-
dicted products in case of calibration data). For example, a workflow might include two actions BIAS
and MOS_CAL. The former creates a master bias from raw biases, and the later creates (among other
products) a master flat from raw flats and arcs. The MOS_CAL action needs raw lamp frames (arc and
flat field) and the master bias (or a set of raw biases) as input. In this case, these biases will have the
purpose BIAS.MOS_CAL. The same DataSet might also include biases with a different purpose, e.g.
BIAS.MOS_SCIENCE. Irrespective of their purpose the file category for all these biases will be BIAS.

Take into account that currently the Data Organizer cannot handle .xml files created by CalSelector. See
the FAQ for details.

2. Next the DataSet Chooser displays the DataSets available in the “Select Data Sets” window8, acti-
vating a vertical scroll bar on the right if necessary (see Figure 4.3). Sometimes you will want to reduce
a subset of these DataSets rather than all DataSets, and for this you may individually select (or de-select)
DataSets for processing using the tick boxes in the first column, and the buttons Select All and
Deselect All at the bottom left.

7OCA stands for OrganisationClassificationAssociation and refers to rules, which allow to classify the raw data according to the
contents of the header keywords, organise them in appropriate groups for processing, and associate the required calibration data for
processing. They can be found in the directory <install_dir>/share/esopipes/<pipeline-version>/reflex/,
carrying the extension.oca

8If you run the Data Organiser in Lazy Mode, changes in the Keywords to be displayed list will have no effect on
the output shown in the DataSet Chooser.
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You may also highlight a single DataSet in blue by clicking on the relevant line. If you subsequently click
on Inspect Highlighted , then a “Select Frames” window will appear that lists the set of files that
make up the highlighted DataSet including the full filename and path for each file, the file category (from
the FITS header), and a selection tick box in the right column (see Figure 6.3). The tick boxes allow you
to edit the set of files in the DataSet which is useful if it is known that a certain calibration frame is of
poor quality (e.g: a poor raw flat-field frame). The list of files in the DataSet may also be saved to disk as
an ASCII file by clicking on Save As and using the file browser that appears.

By clicking on the line corresponding to a particular file in the “Select Frames” window, the file will be
highlighted in blue, and the file FITS header will be displayed in the text box on the right (see Figure 6.3),
allowing a quick inspection of useful header keywords. If you then click on Inspect , the workflow will
open the file in the selected FITS viewer application defined by the workflow parameter FITS_VIEWER.

To exit from the “Select Frames” window, click Continue , and to exit from the “Select DataSets”
window, click either Continue in order to continue with the workflow reduction, or Stop in order
to stop the workflow.

The categories and purposes of raw files are set by the DO, whereas the categories and purpose of products
generated by recipes are set by the RecipeExecuter (see Sect. 6.2.3). The file categories are used by
the FitsRouter to send files to particular processing steps or branches of the workflow (see below). The
purpose is used by the SofSplitter to generate input SoFs for the RecipeExecuter and the results are
collected by the SofAccumulator. Note that while the DO includes files into a DataSet for a reason, and
records this reason as the “purpose” of the file, the workflow itself can use these files in a different manner. The
SofSplitter and SofAccumulator accept several SoFs as simultaneous input. The SofAccumulator
creates a single output SoF from the inputs, whereas the SofSplitter creates a separate output SoF for each
purpose.

6.3.2 Step 2: Creation Of Master Calibration Files

In this step of the workflow, the following VIMOS recipes are executed in the order listed below. Please refer
to the VIMOS pipeline user manual (Izzo et al. 2012: Sections 9 and 10) for the details of each recipe and the
algorithms employed:

1. The MasterBias actor will execute the VIMOS pipeline recipe vmbias in order to create a combined
master bias frame from the set of raw bias frames

2. The VimosMosCalib actor will execute the VIMOS pipeline recipe vmmoscalib in order to create
from the set of raw flat and arc frames a combined master flat frame as well as coefficients for wavelength
calibration and correction of spatial distortions.

6.3.3 Step 3: Response Computation

In this step of the workflow, the ResponseCurve actor will determine the response function (if a flux standard
star is provided) using the recipe vmmosscience, which will subsequently be used to flux-calibrate the science
observation. Please refer to the VIMOS pipeline user manual (Izzo et al. 2012: Sections 9 and 10) for the details
of this recipe.
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Figure 6.3: The “Select Frames” window with a single file from the current Data Set highlighted in blue, and the
corresponding FITS header displayed in the text box on the right. Hidden partially behind the “Select Frames”
window is the “Select DataSets” window with the currently selected DataSet highlighted in blue.
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Note that this actor will be skipped if there are no observations of a standard star in the current DataSet. A
standard star observation is only included in the DataSet for a science observation if it was taken within ±7
nights of the science observation. For some combinations of grism and filter, VIMOS PI-Packs as well as
CalSelector data sets are supplied with master instrument response curves. These are currently not included in
the data set for a science observation.

6.3.4 Step 4: Science Reduction

The VimosScience actor will execute the VIMOS pipeline recipe vmmosscience to apply sky subtraction
and extract the spectra. Please refer to the VIMOS pipeline user manual (Izzo et al. 2012: Sections 9 and 10)
for the details of this recipe and the extraction algorithms employed. The VIMOS/MOS workflow will flux-
calibrate the science observation using the instrument response curve derived from the standard star observation
if it exists in the current DataSet. If no standard star observation exists in the current DataSet, then the science
observation will not be flux-calibrated.

6.3.5 Step 5: Output Organisation

After having processed the input data for a DataSet, the Data Filter actor allows the user to inspect the
results and select which files to save. By default this actor is set to skip and all products will be saved. Next the
workflow highlights and executes the Product Renamer actor, which, by default, will copy the defined final
products of the VimosScience actor to the directory specified by END_PRODUCTS_DIR and rename them
with names derived from the values of certain FITS header keywords. Specifically, final products are renamed by
default with names of the form <HIERARCH.ESO.OBS.NAME>_<HIERARCH.ESO.PRO.CATG>.fits,
where <HIERARCH.ESO.OBS.NAME> and <HIERARCH.ESO.PRO.CATG> represent the values of the cor-
responding FITS header keywords. These names are fully configurable by right-clicking on the Product
Renamer actor, selecting Configure Actor, and then editing the string as appropriate.

The final products that are copied and renamed are:

• <HIERARCH.ESO.OBS.NAME>_MOS_SCIENCE_REDUCED.fits Extracted 1D scientific spectra

• <HIERARCH.ESO.OBS.NAME>_MOS_SCI_ERROR_REDUCED.fits Errors on extracted 1D spec-
tra

• <HIERARCH.ESO.OBS.NAME>_MOS_SCI_SKY_REDUCED.fits Extracted 1D sky spectra

• <HIERARCH.ESO.OBS.NAME>_MOS_UNMAPPED_SCIENCE.fits Sky subtracted scientific spec-
tra unrectified

• <HIERARCH.ESO.OBS.NAME>_MOS_SCIENCE_EXTRACTED.fitsRectified scientific spectra wiht
sky subtracted

• <HIERARCH.ESO.OBS.NAME>_MOS_SCIENCE_SKY_EXTRACTED.fits Rectified science spec-
tra with sky

• <HIERARCH.ESO.OBS.NAME>_MOS_SCIENCE_SKY.fits Rectified sky spectra
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• <HIERARCH.ESO.OBS.NAME>_MOS_SCI_UNMAPPED_SKY.fits Sky on CCD unrectified

• <HIERARCH.ESO.OBS.NAME>_MOS_SCI_GLOBAL_SKY_SPECTRUM.fitsGlobal sky spectrum
(only if parameter –skyglobal is set)

• <HIERARCH.ESO.OBS.NAME>_OBJECT_SCI_TABLE.fits Positions of detected objects

• <HIERARCH.ESO.OBS.NAME>_MOS_SCIENCE_FLUX_REDUCED.fits If flux calibration is done
(if an standard star is present): Flux calibrated scientific 1D spectra

• <HIERARCH.ESO.OBS.NAME>_MOS_SCI_ERROR_FLUX_REDUCED.fits If flux calibration is done
(if an standard star is present): Errors on flux calibrated 1D spectra

• <HIERARCH.ESO.OBS.NAME>_MOS_SCIENCE_FLUX_EXTRACTED.fits If flux calibration is done
(if an standard star is present): Flux calibrated 2D slit spectra

All products with <HIERARCH.ESO.OBS.NAME>_REDUCED are created only if spectra are identified and
can be extracted. All products <HIERARCH.ESO.OBS.NAME>_<type>_FLUX are created only if flux stan-
dard star observations are provided and the standard star flux table is available.

The remaining actors in this step of the workflow are concerned with the termination of the data flow for the
current DataSet and will highlight briefly as they are executed.

6.4 Interactive Windows

The VIMOS MOS workflow contains three interactive windows that allow the user to iterate on the processing
of their data. They are described below.

6.4.1 vmmoscalib

The interactive window shown in Fig. 4.4 (p. 13) provides information about the quality of the wavelength
calibration (left column), distortion correction (top right and center plot) and the flat field combination and
normalization (bottom right plot). The plots contain in detail:

Top Left Wavelength map The wavelength map has as pixel values the wavelength of a pixel. All slitlets should
be present, the regions of the slitlets should not be strongly curved nor should regions of different slitlets
overlap with each other.

Top Center First raw flat This plot is mostly of interest in comparison to the Top Right and Top Left one, as
the number of slitlets and the areas covered by them should be identical.

Top Right Normalized master flat The normalized master flat field should have the same number of slitlets as
the first raw flat and their areas should also be identical. The red lines show the traces of the slitlet edges.
They should therefore follow the slit edges and not cut across slitlets. All slitlets should be detected and
there should be no spurious detections (e.g. one slitlet detected as several).
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Center Left Residuals between predicted and detected arc line position The residuals should generally be
below 0.5 pixel. If they show systematic varitions the polynomial degree used to fit the dispersion relation
may be too low (or in rare cases too high). If the scatter appears very large one should zoom in, because
there are often only a few outliers and the majority of the residuals are within ±0.5 pixels. Middle-clicking
with the mouse on a line will add the catalogue line nearest to this position to -ignore_lines. Doing
this again after re-running the recipe, however, will overwrite previously ignored lines.

Center Right Detected (black), identified (green) and rejected lines (red). If you see a large number of rejected
lines zoom in to verify that this is really a problem. The limited plot size can give a wrong impression.

Bottom Wavelength-calibrated arc lamp frame: In this plot the arc lamp lines should run straight from top to
bottom without any empty rows between them. Some arc lines may show gaps due to the placement of the
slits, but empty rows without any lines point towards problems with the detection of the arc lamp lines.

The buttons in the bottom right window allow to switch between extensions for multiplexed data. For multiplex
data one should always verify the results for all extensions, as parameters which improve some extension may
give worse results for others.

6.4.2 vmmosscience (Response)

The interactive window shown in Fig. 6.4 provides information about the quality of the response curve fit:

Top Extracted standard star spectrum: The extracted standard star spectrum should shows no jumps or sky
emission lines. Strong gradients due to order separating filters are valid but may cause problems with the
fit of the response curve.

Center Raw response and fit: The dots show the raw response (ratio of reference spectrum and observed
spectrum integrated over same bins as reference spectrum) and the blue line shows the corresponding fit.
Blue dots are masked (ignore_resp_mode, ignore_resp_points) and not used for the fit.

Bottom Flux-calibrated standard star spectrum and reference: The red line marks the observed standard star
spectrum calibrated with its own response curve and the green and blue points indicate the reference data
(blue points were masked during the fitting of the response). Differences between the green points and the
red line indicate a problem with the flux calibration, usually features on a scale smaller than the bins of
the reference data. Differences between the red line and blue points indicate problems with inter- and/or
extrapolation.

The buttons in the bottom right window allow to switch between extensions for multiplexed data.

6.4.3 vmmosscience (Science)

The interactive window shown in Fig. 6.5 provides information about the quality of the sky subtraction and
spectrum extraction. It shows the spectra in ADU/sec, i.e. not flux-calibrated:
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Figure 6.4: The interactive window of the ResponseCurve actor for the first demo DataSet.

Top Mapped sky-subtracted 2-dimensional spectrum: The wavelength-calibrated, rectified frame is shown after
sky subtraction. The yellow and red lines mark the lower/upper extraction limits of the detected spectra.
Right-clicking on such a range will plot the extracted spectrum in the Bottom plot.

Bottom Extracted science spectrum: The spectrum should not show strong residuals of sky lines.

The buttons in the bottom right window allow to switch between extensions for multiplexed data.
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Figure 6.5: The interactive window of the VimosScience actor for the first demo DataSet.
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7 Improving Your Results Through Workflow Interaction

In this section we provide information on how to improve your results by changing the parameters of the
vmmoscalib and vmmosscience recipes.

7.1 Demo Data

DataSet 1 The interactive window for the wavelength calibration of the sceince shows quite a few rejected lines
(red dots in center right window) and a large scatter in the residuals at the blue end (center left window).
This can be improved by setting wradius to 0, i.e. switching off the iteration of the wavelength fit.

The response curve ends in a masked telluric region. In order to avoid extrapolation the response is
only fit between the bluest and the reddest unmasked points. To see the effect of the masking you
can change resp_ignore_mode from stellar_absorption,telluric,command_line to
stellar_absorption,command_line and rerun the recipe. Now the fit is less good because more
(and deviating) points need to be fit, so the fit parameters need to be changed as well. The feature between
5650 Å and 6150 Å is an instrumental feature, that is corrected by the use of the flat field SED.

DataSet 2 The wavelength calibration of the flux standard shows some distortions in the wavelength calibrated
arc frame. This can be improved by setting wreject=0.7.

The spectrum of the flux standard star is shifted by 90 Å, relative to the tabulated values. Setting resp_shift
to -90 corrects this offset.

7.2 Wavelength Calibration

For multiplex data one should always verify the results for all extensions, as parameters which improve some
extension may give worse results for others.

Failures for the various grisms can be recovered in many cases by the following parameter changes:

• LR_blue increase peakdetection to 100 (for failure during slit identification)

• LR_red reduce wreject to 0.4

• HR_blue reduce peakdetection to 30 and/or increase wreject to 2.5

• HR_orange reduce wreject to 0.4 and/or reduce peakdetection to 30

• HR_red decrease wdegree to 4 (reducing wreject to 0.7 or peakdetection to 2500 is also
sometimes helpful)
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8 Frequently Asked Questions

• The error window fills the whole screen - how can I get to the Continue / Stop buttons?

Press the Alt key together with your left mouse button to move the window upwards and to the left. At
the bottom the Continue / Stop buttons will be visible. This bug is known but a fix has not yet been
found.

• Where are my intermediate pipeline products? Intermediate pipeline products are stored in the direc-
tory <TMP_PRODUCTS_DIR> (defined on the workflow canvas) and organised further in directories by
pipeline recipe.

• Can I use different sets of bias frames to calibrate my flat frames and science data? Yes. In fact this
is what is currently implemented in the workflow(s). Each file in a DataSet has a purpose attached to it
(Forchì (2012)). It is this purpose that is used by the workflow to send the correct set of bias frames to the
recipes for flat frame combination and science frame reduction, which may or may not be the same set of
bias frames in each case.

• Can I run Reflex from the command line? Yes, use the command:

reflex -n <workflow_path>/<workflow>.xml

The -n option will set all the different options to Kepler and the workflows that avoid any graphical display
(including pipeline interactive windows). Note that this mode is not fully supported, and the user should
be aware that the path to the workflow must be absolute and even if no GUI elements are shown, it still
requires a connection to the window manager.

• How can I add new actors to an existing workflow? You can drag and drop the actors in the menu
on the left of the Reflex canvas. Under Eso-reflex -> Workflow you may find all the actors
relevant for pipeline workflows, with the exception of the recipe executer. This actor must be manu-
ally instantiated using Tools -> Instantiate Component. Fill in the “Class name” field with
org.eso.RecipeExecuter and in the pop-up window choose the required recipe from the pull-
down menu. To connect the ports of the actor, click on the source port, holding down the left mouse
button, and release the mouse button over the destination port. Please consult the Reflex User Manual
(Forchì (2012)) for more information.

• How can I broadcast a result to different subsequent actors? If the output port is a multi-port (filled
in white), then you may have several relations from the port. However, if the port is a single port (filled in
black), then you may use the black diamond from the toolbar. Make a relation from the output port to the
diamond. Then make relations from the input ports to the diamond. Please note that you cannot click to
start a relation from the diamond itself. Please consult the Reflex User Manual (Forchì (2012)) for more
information.

• How can I run manually the recipes executed by Reflex? If a user wants to re-run a recipe on the
command line he/she has to go to the appropriate reflex_book_keeping directory, which is generally
reflex_book_keeping/<workflow>/<recipe_name>_<number> There, subdirectories exist with the time
stamp of the recipe execution (e.g. 2013-01-25T12:33:53.926/). If the user wants to re-execute the most
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recent processing he/she should go to the latest directory and then execute the script cmdline.txt.
Alternatively, to ensure that the path to esorex is the correct one, the user can execute

ESOREX_CONFIG="INSTALL_DIR/etc/esorex.rc"
INSTALL_DIR/bin/esorex --recipe-config=<recipe>.rc <recipe> data.sof

where INSTALL_DIR is the directory where Reflex and the pipelines were installed.

If a user wants to re-execute in the command line a recipe that used a given raw frame, the way to find the
proper data.sof in the bookkeeping directory is via grep <raw_file> */data.sof. Afterwards
the procedure is the same as before.

If a recipe is re-executed with the command explained before, the products will appear in the directory
from which the recipe is called, and not in the reflex_tmp_products or reflex_end_products directory, and
they will not be renamed. This doesn’t happen if you use the cmdline.txt script.

• If I enter "-" into an empty integer parameter it is automaticaly completed to "-1". Why?

The parameters are validated for correctness according to their type (e.g. string, integer, float). In the
case of an integer or float parameter "-" alone is considered an invalid input and is therefore automatically
completed to "-1". This is part of the validation of input done by the WxPython library.

8.1 VIMOS specific questions

• If I click on "Use the parameters above as initial values in subsequent executions of this recipe",
some changes are ignored

The VIMOS pipeline has a special way to handle the parameters which are in the configuration tables.
Basically, the initial values are always taken from the configuration table. Still, during the loop execution,
the parameters can be changed to the desired values.

If you want to use different values as "initial values" for those parameters, edit the configuration tables
(VIMOS_GRS_* to create your own version. The paremeters affected are: dispersion, peakdetection,
wdegree, cdegree, reference, startwavelength, endwavelength, resp_use_flat_sed,
resp_fit_degree, and resp_fit_nknots.

• Can I use the .xml file that is produced by CalSelector as an input of the DO?

Currently no. As of current release the static calibrations in the ESO archive are not compatible with the
pipeline. Therefore one has to use the static calibrations installed along with the pipelines. The .xml file
produced by CalSelector contains only static calibrations from the archive, making the pipeline fail. This
will be fixed in next releases, once the ESO archive has been updated with all the new calibrations.

• I see small dark and bright regions in my normalized flat field - why?

These features are caused by straylight from 0th order light in adjacent slitlets. As the pipeline no longer
normalizes the flat fields column-by-column/row-by-row, but uses an average along the rows/column
instead this effect is currently not corrected. This should be improved in a later release. The science data
will also be contaminated by the 0th order light, but in a different way as the flat field spectra are all from
one source while the science spectra are created by different sources.
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• I am using the maximum number of knots for the spline fit of the response but the fit still does not
go through all data points.

The maximum number of knots for the spline is the number of unmasked data points – 2 (entering a higher
number will cause the pipeline to reduce it to the allowed maximum). Since the knots are distributed at
equal distances this means that the distance between two knots is always larger than the distance between
two data points. This explains why even at a maximum number of knots the fit may not go through all
data points. A polynomial of very high degree might achieve that, but is rather unstable.

• I get a warning “Column STLLR_ABSORP not found in std star table. Value ’stellar_absorption’
in ’resp_ignore_mode’ is ignored” if I use the standard star tables that have been downloaded from
the archive with CalSelector.

This may happen for data from old PIPacks or for data that were downloaded before August 1, 2015,
when old static calibration files were delivere. You should remove these files from your input files. Since
the static calibrations are also delivered together with the latest version of the pipeline, you don’t really
need them, Reflex will take the ones under directory CALIB_DATA_DIR.

• If I change resp_use_flat_sed to false for MR data the flux-calibrated data have signficantly
higher flux - why?

This is due to the fact that the normalization factor for the flat field SED of the science data is derived from
the standard star flat fields. For a constant lamp flux in ADU/sec this would be irrelevant. However, the flat
fields for the science data are usually taken during the night at the same rotator angle as the science data.
They suffer from vignetting, whose amplitude depends on the rotator angle, while the daytime calibrations
are taken at an optimized rotator angle to minimize flux losses. Therefore the normalization factor derived
from the standard flat fields is not correct for the science flat fields, which causes an underestimation of
the flux in spectra flux-calibrated with flat field SED correction. You can correct this factor by comparing
the flux in ADU/sec between the attached science flat fields and the corresponding ones taken during day
time.

• Why do my flux-calibrated data not agree with independent photometric measurements?

In order to have a true absolute flux calibration several requirements need to be fulfilled:

1. All flux of both the target and the standard star needs to collected, i.e. a wide slit has to be used.

2. The transparency does not change between the observations of the target and the standard star.

With respect to the first condition one should keep in mind that the flux standard stars are observed with
a 5” wide slit, while science data are typically observed with slit widths of 0.8” to 1”. For a seeing of
0.8” a slit width of 0.8”/1.0” means that some 33%/24%, respectively, of the target flux are lost (see also
Fig. 8.1). This would result in a too low flux for the flux calibrated spectrum of the target.

If the second conditions is not fulfilled, i.e. the standard star or the target or both are observed under
non-photometric conditions (e.g. CLR or THN) their observed flux will be lower than it should be. If
the standard star is observed under photometric conditions but the science target is not the flux in the
flux calibrated target spectrum will be too low. The opposite happens if the target is observed under
photometric conditions but the standard star is not. CLR/THN conditions allow for transparency variations
of 10%/20%, respectively.
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Figure 8.1: Here a Moffat profile with a FWHM of 0.8” is shown. The dashed and dotted lines mark the limits
of a 0.8”/1.0” slit..

• Does the pipeline combine different detectors chips into a common product?

No. The spectroscopic pipeline and Reflex workflow works only on files from the same detector chip.
Files from different detectors must not be mixed in the same sof.
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9 Troubleshooting

In this section we describe some of the problems that may occur when reducing the VIMOS/MOS with the
ESOrex pipeline. For a more comprehensive description we refer the user to the VIMOS user manual
(http://www.eso.org/sci/software/pipelines/).

1. I have data from the old PI packs

The data from the DVD have to be cleaned up:

• remove all the pipeline products i.e. master bias (whose filename contains the string MBIA), trans-
mission response files (whose filename contains the string PTNF) and directories labelled as proc
or reduced

• remove duplicate files (i.e. files with the same name, but stored in different directories, such as arc
lamps).

• remove all old static calibrations.

2. Should I change the CALIB_DATA_DIR configuration?

This directory is setup automatically to point to the calibration database provided with the pipeline and
in principle shouldn’t be changed. However, if static calibration data are present in the RAWDATA_DIR
(e.g. calibrations are downloaded from the archive, or copied from ESO-DVD distribution), then you
might have to remove these data (otherwise an obsolete static calibration file may be selected instead of
the most appropriate one).

3. If I set parameter resp_ignore_mode to empty in the response interactive window, the value
stellar_absorption,telluric,command_line is taken

This is a known bug in Reflex that will be solved in next release. As a work-around, set resp_ignore_mode
to command_line and resp_ignore_points to empty, in order to express that no masking has to
be done.

4. Bug: MODE mismatch between BIAS frames and pixel tables

It can happen that the BIAS frames associated to the reduction flow of one MOS observation was taken
in the imaging mode. The bias can be used, as there is no difference between bias taken in imaging or
MOS modes. Nevertheless, the vmbias recipe requires the bias frame and the bad pixel table9 to have
the same observing mode. This bug can be overcome by changing the OBSMODE in the bias frames from
IMG to MOS. This bug is in the vmbias recipe, independent from the reflex workflow, and it may be
solved in future VIMOS pipeline releases.

9CCD_TABLEs are static calibration files, one per quadrant, one set per observing mode, containing the list of bad pixels. See
Section 6.2 in the VIMOS pipeline user manual (version 6.5).
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